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Course Scheduling Introduction 
 
Scientia Enterprise Timetabler (TT) is the scheduling system used by UBC Vancouver Timetabling 
Representatives (T-Reps) once the draft course schedule is released. T-Reps can use TT to generate new 
activities, enter and update planned size and assign resource requirements like, days, times, locations, 
and instructors to support course scheduling for their academic unit. T-Reps also use Workday to 
complete the set-up of courses for registration.  
 
Access to Scientia and Workday systems are associated with a user’s position. If you have questions 
about your Course Scheduling access, please use the UBC Self-Service Portal and "Request Workday 
Student Support" (select "Access and Role Request" for the Category) and complete the form. 
 
This guide introduces Scientia Timetabler. Users should read this guide in conjunction with the Workday 
Course Scheduling Training on Canvas. This document aims to provide users with step-by-step processes 
while also providing information on why the recommended processes should be followed and tips to 
efficiently and effectively use Scientia.  
 
For information on how to use Web Data Collector (WDC) to input scheduling requirements at the 
beginning of the scheduling process, please refer to the WDC User Guide.  

Please review the Academic Course Scheduling Operational Procedures for principles, timelines and 
guidelines. If you require support or have questions, contact us via the Course Scheduling Request Form. 
 
It is recommended that users have both Scientia and Workday launched when doing course scheduling 
after the draft timetable is released to make it more efficient to move between the systems.  
 
The workflow below outlines how the systems interact: 
 

 
Note: While the transfer from Scientia to Workday is supposed to be 30 minutes, transfers may take 
longer and include an overnight refresh. Reach out to our team if your update does not appear in 24 
hours. 

mailto:schedulingservices@students.ubc.ca
https://ubc.service-now.com/selfservice
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Scientia Database Navigation and Overview 
 
How to log into Scientia 
Once a Timetable Representative (T-Rep) is set-up with the correct security access, Scientia is accessible 
from the Scheduling Dashboard in Workday (WD). Use UBC-VAN Scheduling - Courses & Events (Scientia) 
from the Scientia Links tab. Scientia must be launched using the Microsoft Edge browser while you are 
connected to UBC’s VPN application.  
 
If you are having issues accessing the Scheduling Dashboard in WD, please see the Workday Course 
Scheduling Training Course. 
 
Note: If you are a new Mac User, contact Scheduling Services and provide your CWL as you will need to 
use a VDI to access Scientia. We will submit a ticket to Desktop Services to have an EduCloud account 
created for you. 
 
To access Scientia: 

1. Select the correct database tab 
• The database tab will be named after the corresponding Academic Year (ex. 

2024W_2025S) 
• The database you are loading will be highlighted a dark shade of blue 

 
2. Click on Enterprise Timetabler and select Run 
3. Select Reload data from the server as this is the quickest loading option 

 
 
Note: You will need to select Install Scientia the first time you use it on your computer.  
 

mailto:schedulingservices@students.ubc.ca
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Key Scientia Terminology 
It is helpful to understand the following terms while using Enterprise Timetabler (TT): 

Academic Year 
• The academic year databases in Scientia are set up per academic year. 
• Each academic year’s database is set up August to August and not per Academic Period 

(Term).  
o For example; Week 1: August 19, 2024 and Week 52: August 11, 2025 
o Winter and Summer sessions share one database (ex. 2024W and 2025S) 

• There are typically 52 weeks in Scientia per database. In the case that there is a leap year, 
the database will show 65 weeks.  

• Listed below are examples of the corresponding weeks of frequently used Named 
Availability Patterns (NAPs): 

o Winter Term 1: Weeks 3-16 
o Winter Term 2: Weeks 21-26, 28-34 
o Winter Term All: Weeks 3-16, 21-26, 28-34 
o Summer Term 1: Weeks 39-44 
o Summer Term 2: Weeks 46-51 
o Summer Term All: Weeks 39-44, 46-51 

 
Locations in Scientia are made up of mostly General Teaching Spaces and some Restricted 
Teaching Spaces. It does not include research, administrative and ancillary spaces. The learning 
Spaces team in UBC Facilities manages and regularly updates the list of locations available for 
booking for courses. 

 
Suitabilities in Scientia include the room features and amenities in General Teaching Space 
(GTS) classrooms, such as AV equipment or specific types of furniture. If you need to add new 
Suitabilities, please contact Learning Spaces at learning.spaces@ubc.ca and cc Scheduling 
Services at scheduling.services@students.ubc.ca. 
 
Restricted Teaching Space (RTS) is designated to particular faculties and departments, and only 
the designated faculty or department can book an RTS. RTS are not available for booking by other 
departments and faculties. At the start of each academic session, all RTS from the previous year 
will appear in Web Data Collector.  
 
General Teaching Space (GTS) is shared space used for the teaching needs of faculties, 
departments and schools. GTS maintenance is managed by the Learning Spaces Team and room 
booking requests are administered by Scheduling Services. The UBC Space Rental Policy (UP9) 
further defines General Teaching Spaces.  
 
Named Availability Patterns (NAP) 
• Pre-defined week patterns apply to activity templates or to individual activities 

o For example; Winter Term 1, Winter Term 2, Winter Term 1 Odd Weeks, Winter 
Term 1 Even Weeks 

o NAPs are created and maintained by Scheduling Services 
o Users select a pattern when setting up a new course section 

mailto:schedulingservices@students.ubc.ca
https://facultystaff.students.ubc.ca/sites/facultystaff.students.ubc.ca/files/UBC%20Vancouver%20Room%20Suitabilities.pdf
mailto:learning.spaces@ubc.ca
mailto:scheduling.services@students.ubc.ca
https://universitycounsel.ubc.ca/policies/space-rental-policy/
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Modules 
• Modules in Scientia are brought in from the Course Definition in Workday that are 

available to be scheduled for a specific session (Winter or Summer) 
• Modules will appear twice in Scientia, one with a -S and one with a -W extension. The -S 

(Summer) or -W (Winter) identifies which session the module should be scheduled 
o Module = course code + course number + course topic title, e.g. detail code, A, B 

etc. (if applicable) (ex. CIVL_V 498N-W) 
 

Activities 
• Activities in Scientia most commonly relate to the course section definition in Workday. 

Activities define the type of delivery, days, times, term/academic period, and location. A 
section can have multiple activities, so do not always assume activity = section.  

• The section ID field in Scientia is the key field for linking activities to the same section. If 
you give multiple activities the same section ID, it will connect the days, times, 
terms/academic periods for all the activities for the course schedule and registration.  

o If a course has multiple required instructional formats the section ID must be 
different for across the different required instructional formats. A DIS activity 
can’t have the same Section ID as the LEC activity. 

 
Important Icons 

• Writeback  – The Writeback button is how you save your work and confirm the changes 
to the Scientia database. If you do not click the Writeback icon, your changes will not be 
committed. 

• Refresh  – The Refresh button is used to view what others have saved in the system 
while you are working. It is important to refresh regularly for the most accurate view of the 
Scientia database and avoid double booking errors. 

 
Activity Templates 
Each type of activity needs its own activity template (e.g. LEC activities must come from a LEC template). 
Therefore, if you need to generate an activity you have not generated before, a new activity template 
will need to be created. Instructions on creating new templates and generating activities from existing 
templates can be found here. 

Note: Only Activity Types that match a course’s Required Instructional Format in Workday should be 
used. This will ensure those course sections will transfer to Workday and allow for successful course 
registration. 
 
Enterprise Timetabler (TT) Layout and Set-up 
The 5 main areas of TT  
Users should understand the purpose of the different areas. 

 
1. Icons & Tool Bar – this is a quick menu access to features  
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• Users frequently use the Writeback  and Refresh  icons.  
 

2. Views – find lists of data (ex. Modules, Locations) with the option to search and filter  

 
• Users often search Modules for courses and Locations for classrooms. 

 
3. Activities – a list of course activities based on a search in the Views window and any applied 

filters 

 
• Users view and make edits to activities in this window. 

  
4. Status  

 
• Users can see the number of problems in the system. Problems can include double 

bookings of classrooms or instructors. 

5. Refresh – the time of your latest refresh will be here. 

mailto:schedulingservices@students.ubc.ca
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• Users should click the Refresh  icon regularly, especially before writing back changes 
to the database. This will ensure you do not accidentally double-book a room and that 
you see the most up to date information. 

 

Column Views & Filtering 
Adding Columns 
Users can customize the screen layout to show the relevant data columns. Choosing the correct columns 
ensures you have the information you need to help update and schedule your activities. 

To add columns, you will right-click on the header row and select Column Chooser. To add it to the 
header row, there are two options: 

1. Select the column name and drag it to the header row 
2. Double-click on the column name and it will automatically add to the header row 
 

Recommended Column Layout 

Add the following column option in order to have all required information to view and edit your 
activities: 

• Activity Type Name 
• Name 
• Module Name 
• Section ID 
• Planned Size 
• Department Name 
• Duration 
• Scheduled Days 
• Scheduled Start Time 
• Scheduled End Time 
• Scheduled Weeks 
• Allocated Location Name 
• Required Staff Name 
• Allocated Staff Name 
• Tag Names 
• Scheduled 
• Has Problems 
• User Text 3 (WDC Comment Box) 
• Host Key 
• Activity Template Name (all activities should have an Activity Template Name) 

 
Removing Columns 
There are two ways to remove columns: 

1. Right-click on the header row, and select Remove This Column 
2. Select the column and drag it into the blank area of the screen. An ‘X’ will appear as you 

drag.  
3. Let go and the column will be removed. 

mailto:schedulingservices@students.ubc.ca
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Auto-Filter Row 
The auto-filter row will allow you to type in the fields and filter to search quickly. To add an auto-filter 
row, you will right-click on the header row and select Show Auto Filter Row: 

 
• Remember to remove the filter after use. You can do this by deleting the content within the 

auto filter row or by clicking the X at the bottom of the activities window: 

 
 
Staff Double-Booking Constraint  
Before editing any activities, turn off the double-booking constraint for staff.  

1. Click on Tools, and select Constraints. This will open up a new window.  
2. Go to the top section where it indicates Avoid Double Booking Constraint.  
3. Next to Staff Member, select Never, and then select OK at the bottom of the window. 

Note: Sometimes staff are intentionally attached to overlapping activities and if the staff 
double-booking constraint stays on and there is a scheduling conflict for the instructor, you will 
not be able to edit the activity. 

 

 

Using Enterprise Timetabler (TT) for Course Scheduling 
 
Users will use Enterprise Timetabler (TT) to complete the following steps in the scheduling process: 

• Reviewing activities allocated GTS by Scheduling Services 
• Updating activities in GTS, if desired 

mailto:schedulingservices@students.ubc.ca
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• Assigning and editing allocated staff 
• Scheduling and updating activities in RTS 
• Adding new activities 

 
Generating a New Activity for the Course Schedule 
In order to ensure activities will transfer from Scientia to Workday all activities must be generated from 
an activity template. If you need to generate a new activity for a course and a section already exists in 
Timetabler follow these steps: 

1. Highlight the existing activity, right-click and select Generate From Template 

 
2. A new line will appear for the newly generated activity. The newly generated activity 

will inherit all the details of the template. 

 
Note: If an activity does not already exist in Timetabler, please submit a Course Scheduling Request 
Form and Scheduling Services will generate it for you. 

3. In order to set up a newly generated section you will have to open the Activity Editor 
window, to do so double-click on the activity in the Activity window to open the 
Activity Editor window. You will need to enter key information to ensure that the 
section will transfer properly to Workday.  

• Duration 
• Planned Size 
• Section Id 
• Availability (i.e. Academic Period) 

 

mailto:schedulingservices@students.ubc.ca
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How to update a Section ID 
A section ID is the unique identifier for the activity. This field should only be edited when setting 
up a new section. The Section ID cannot be updated after the Section ID has been saved in TT. 
Doing so can lead to WD integration issues. A Section ID should be 3 digits and use numbers 
and/or letters. 
 

To update: 
a. Double-click on the course section to open the Activity Editor window.  
b. Under Details, add the section ID to the end of the name 
c. Under Sections, add the section ID 
d. Then click OK.  

 

 
 

4. Once you have completed the above fields, you can input scheduling information into 
the Resources Tab and schedule the section or tag as arranged if there are no set 
days/times. Please see the Editing Scheduled Course Sections section for more 
information about making changes in the Resources Tab and Activity Editor window.  

• If there is an off-campus or no physical location required, set the required resource 
to 0 in the Location section.  

 
5. After a location has been assigned or the activity is scheduled without a location, 

the Scheduled column will display a check mark in the Activities window: 

mailto:schedulingservices@students.ubc.ca
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6. If the ‘Has Problems’ box for your course section is checked off after you writeback 
your changes, you should check to see what the error is: 

 
 
 
 

 
a. Highlight and right-click on the course section in the Activities window.  
b. Select View Related Problems and a window will show up.  
c. If the error that shows is Constraint: Avoid Double Booking Constraint, expand on 

the error by selecting the + sign on the left.  
d. Check to make sure that your staff is not double booked for two or more sections 

that require their attendance.  
e. If the double-booking is okay after checking, you can disregard this error and select 

Close. 
 

The scheduled activity will appear in the Combined Timetable grid for the days and times 
scheduled: 

 
 

Editing Scheduled Course Sections 
When the draft timetable is complete and T-Reps are given access to Scientia, all course sections requiring 
GTS will be allocated to GTS. You may make changes to these sections yourself, including searching for a 
different location, changing planned size, duration, and day/time.  
 
When making changes to sections, work is done in two distinct areas: 

1. Activity Editor window is where you can update the Duration, Planned Size, input a Section ID, 
add the Arranged tag, or select an Availability Pattern. This field should only be edited when 
setting up a new section. The Section ID field can only be edited when setting up a new section 
and should not be changed after it has been saved in TT. 

mailto:schedulingservices@students.ubc.ca
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2. The Resources Tab is where you can update resources including instructor or location and adjust 

the days or times that a course is to be scheduled. The Resources tab is split into two sides the 
left side shows the course section Requirements while the right side shows the Current status.  

 
 
What to be aware of when editing scheduled course sections 

• To edit most activities, you must unschedule the activity first (right-click on the activity and select 
‘Unschedule’) in order to make most changes.  The only exceptions to this are: 

o adding or changing Staff (i.e. instructors)  
o changing the location 
o updating the planned size 

• Always remember to Refresh the database and Writeback  to save your changes. 
• When changes are made to the activity, the previously allocated GTS may not meet the new 

requirements and you may have to look for a new location. For example, if changes are made to 
the time and day of the activity, the allocated GTS may already be assigned to another activity at 
the new time.  

• The Section ID, availability (Academic Session/Term), and activity type of a course section should 
not be changed, doing so can create errors that may impact registration. If you need to change 
the Section ID or Term for a course, a new section should be created. See Generating a New 
Activity for more information. 

 
How to edit Availability (i.e., Academic Period) 
The academic period (Term) cannot be changed for a Winter Term course section if students are 
registered or if the Term has already started. If the term has already started, or students are registered 
a new section must be created with a new section ID. Additionally, changes to the start date of a course 
within an academic period can only be made prior to the start of the academic period. If the change is 
made before of the start of the Term and no students are registered please reach out to Scheduling 
Services to ensure that the change propagates to WD.   

mailto:schedulingservices@students.ubc.ca
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1. Ensure the course is in an unscheduled state. 
2. In the Activities window, double-click on the course section to open the Activity Editor 

window.  
3. At the bottom of the Activity Editor window, you will see an Availability field. To the right, 

you will see a drop-down arrow.  
4. If you would like to use a Named Availability Pattern (updated annually by Scheduling 

Services), make sure the Use custom availability is unchecked. Scroll through the 
different availabilities and select the one you need.  
 

If there is no Named Availability Pattern (NAP) that fit what you are trying to schedule, you can 
create a custom availability pattern to reflect the weeks the activity must be scheduled.  

1. Follow the above steps 1-3. 
2. Ensure the Use custom availability is checked and then select the weeks in the Teaching 

week pattern you would like the course to run (the selected weeks that the course is to 
run are coloured grey).  

3. After selecting the availability, make sure the Teaching week pattern and availability work 
for the course section.  
Note: Sometimes this process will cause the large week grid in this window to display with 
all the squares greyed out. If this happens, you will need to click through the squares to 
make them appear as white. 

4. Then, click the X at the top left corner and then click OK.  
5. In the Combined Timetable tab, you will see that the availability has changed. Indicated 

by the green bars. When you are done, writeback your changes. 

 
6. After applying the change in the Activity Editor, the weeks that the course is running will 

be indicated with green bars in the Activities area of Timetabler.  

 
 
How to add the Arranged tag 
Arranged courses do not have scheduled dates, times and locations. These are typically course activities 
that are offered asynchronously. Activities that are arranged cannot also be scheduled. 

1. Ensure the course is in an Unscheduled state. 
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2. Check to see if the activity has other tags (ex. Confirmed in WDC) 
3. In the Activities window, double-click on the course section to open the Activity Editor.  
4. In the Tags drop down list, search for Arranged.  
5. Press CTRL and then click on Arranged to highlight it. It is important to ensure you multi-

select all tags, as if you click on just one, all the other selected tags will be removed. 
6. Once all tags are selected, including Arranged, click OK. 
7. Writeback the change when ready. 

 

 
 
Notes: 

• Scheduling an arranged course will cause the section to not sync to Workday and will break the 
data integration process between Scientia and Workday. Please ensure all courses tagged with 
Arranged are not scheduled. 

• If your arranged course section includes some in-person meetings, rooms for these in-person 
meetings should be booked as ad-hoc requests. Please see the Room Bookings website for more 
information. 

 
How to edit Duration 
Duration indicates the length of time the class meets per activity.  

1. Ensure the section is in an unscheduled state. If not, right-click on the activity and select 
Unschedule. 

2. Double-click on the course section to open the Activity Editor window.  
3. Go to the Duration field and adjust your duration as needed. Change the duration by 

typing in the box or using the arrow keys. The duration is listed in half-hour periods, e.g. 
2 means a duration of 1 hour, 3 means a duration of 1.5 hours, and so on.  

4. Click OK.  
5. You may need to search for a new location after changing the duration. Writeback your 

changes only after you have rescheduled the course into an appropriate location.  

mailto:schedulingservices@students.ubc.ca
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How to change the Day/Time of a course section 
Day/Time refers to the start time and days of the week the course section meets. To change the day or 
time of a course section take the following steps: 

1. Ensure the course is in an unscheduled state. 
a. To unschedule the section, highlight and right-click the section and select 

Unschedule.  
2. After the course has been unscheduled, go to the Resources tab. Go to the 

Requirements on the left side of the tab and select the + sign in the row.  
3. Select the day(s) you would like to change to and select the start time. To select 

multiple days, hold down the CTRL key on the keyboard before selecting the days. 
4. Select Change Requirement when you are done.  
5. You can now search for available locations with the new day and time (please see the 

steps in How to find a new location section for more details). Select the location you 
would like and click Accept. 

6. Writeback your changes. 

How to edit Planned Size 
Planned Size indicates the estimated enrolment for the course and is used when allocating GTS. This 
number can be updated. Significantly planned size changes (>10%) should be discussed with Scheduling 
Services in advance of course scheduling.  
 
If you are looking for classroom locations, your search will be limited by the room capacities that meet or 
exceed the planned size. One option to expand your available location options is to remove planned size 
from your search parameters. By unchecking the ‘Use Planned Size’ box in the Activity Editor, the system 
will not look at the room capacity and will use other location requirements defined for the section.  
 
The system will show rooms that are lower than your intended planned size, if available. Please ensure 
that the room you are selecting will work for the size of the course before scheduling. 
 
To update: 

1. Double-click on the course section to open the Activity Editor window.  
2. Click on the check Use Planned Size box to remove or update the planned size number, 

as needed. 
3. Then click OK and writeback your changes when ready. 
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How to add Staff (i.e. instructors)  
The Staff resource can be edited while the course section is in a scheduled state. 
  
To add or remove staff from a course section: 

1. Search for the course and select the section in the Activities window.  
2. Go to the Resources tab and then Requirements on the left-hand side.  
3. If an instructor is required for the section, select the instructor from the Manual 

selection. If you would like to select multiple staff, press down the CTRL key on your 
keyboard and select the additional staff members.  
Note: A maximum of 22 instructors can be added to a course section in Scientia. If more 
than 22 are added, the data integration with Workday will fail for this course, as well 
as, all other courses. 

4. If no instructor is required, such as Exchange, Work Placement, Practicum set the staff 
requirement to 0. 

5. Click Accept when you are done. 
 
How to find a new location 
If a course section is scheduled into a room that is not pedagogically suitable or no longer meets the 
needs of the activity, you can change the location in Timetabler. 
 
Note: The activity does not need to be unscheduled to change the location. 

 
To search for a new location, take the following steps: 

1. Select to highlight the course section you want to review and edit.  
2. In the Resources tab, go to the Current side. Find the row for Location. 
3. Click the Search button on the right side of the screen to see a list of other available 

rooms that meet your resource requirements.  
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4. Refresh the system frequently (click  in the top toolbar) before and while searching 
for available rooms to avoid double-booking a location.  

5. To ensure that the location that you are selecting is large enough, we recommend that 
you add the Capacity column to the Location Search view.  
• To add the Capacity column, right-click on the header row and select Column 

Chooser, there are two options: 
a. Select Capacity and drag it to the header row. 
b. Double-click on Capacity and it will be added to the header row. 

6. If there are rooms available based on the section’s requirements, they will show up 
here. If there is a suitable room, select the room and click Accept. 

 
7. Writeback to save your changes to the database when you are satisfied with the results.  

 
What to do if you cannot find a classroom? 
If you are searching for locations, but no alternative location is available, you may wish to update your 
resource requirements such as changing the location suitabilities, decreasing planned size, and/or day 
and time. Below are recommended next steps.  
 

Location suitabilities work with an “AND” logic so to have more available room options, try 
removing some of your requirements. Location Suitabilities are categorized using the following 
prefixes: B = Building, F = Feature, RT = Room Type, Z = Zone, L = Layout 

 
Note: If an RTS is required, you will need to remove the Z suitability for the location to show. 

 
To remove location suitabilities: 
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1. Search for the course and select the section in the Activities window.  
2. Go to the Resources tab and then Requirements on the left-hand side and click the + to 

expand the Location section. 
3. Click on the arrow bar under Suitabilities to open a new window. 

 
4. Then select the feature you would like to remove and click the back arrow to remove 

this feature from the listed suitabilities. 

 
5. Select Change Requirement and then you can search for other available rooms by 

following the steps detailed in How to find a new location. 
 

Planned Size: If a room with a lower seat capacity will work for the activity, you may want 
Scientia to not look at Planned Size when doing the location search. Please refer to How to Edit 
Planned Size. 
 
Changing the day/time to find a classroom: If a room is available at an alternative time that will 
work for your activity, you may want to change the scheduled day or time to access that room. 
Please refer to How to change the Day/Time of a course section.  
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Splitting Course Sections into Multiple Activities 
If you are still unable to find a suitable room for your activity, you may wish to split up your location search 
to see if you can find different rooms for each day the course is to run. To split up your location search, 
another activity will need to be generated. 
 

1. Highlight the activity, right-click and select Generate From Template. 

 
2. A new line will appear for the newly generated activity.  

 
3. Edit the activity in the Activity Editor with the same details as the original activity. Make 

sure that the same Section ID and availability (Teaching Week Pattern) is given to this 
second activity.  

4. Define the resource requirements to indicate the other day you will need a room. 
5. Update the new activity to include the same resource requirements of the first activity. 
6. Search for a new room. 

 
 
Creating Jointly Taught Activities 
Jointly Taught Activities (JTAs) are also known as cross-listed activities or “overlaps with” in Workday.  
 
Activities should be cross-listed when two or more activities meet on the same days, times, and location 
in order to ensure that the activities transfer to Workday.  

• JTAs should be created in an unscheduled status.  
• All activities that are to be cross-listed should have the same defined Named Availability Pattern 

resource requirements and the same number of Required Instructional Formats.  
 

1. In Views, use Modules and search for the course. 
2. In the Activities window, highlight one of the activities that is to be cross-listed. 
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3. Go Actions and select Jointly Taught Activity. 

 
4. When the Jointly Taught Activities window opens up, search for the other module(s) to 

be cross-listed. 

 
5. Highlight the module that is to be cross-listed and use the arrows in the middle to 

connect the courses. 

mailto:schedulingservices@students.ubc.ca


Scientia Course Scheduling User Guide 
Scheduling Services 

schedulingservices@students.ubc.ca  
 

Last Updated: May 5, 2025  20 
 

 
6. Go to the Options tab and ensure that the All is selected for the Name and Size. This will 

combine the two activity names and the planned sizes. 

 
7. Select OK to apply the changes and select the Writeback icon to save the changes in the 

system. 
8. In the Activities window, the new activity will show a combined name.  

 
9. Review the defined resource requirements and then schedule the cross-listed course. 
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Cancelling a Course Section 

To cancel a course, submit a Course Scheduling Request Form as all cancellations must be processed by 
Scheduling Services. 

Do not delete or unschedule activities in Timetabler as this will trigger significant manual work, cause 
data integration issues with Workday, and possibly result in students registering for the activity. 
Cancellations may take up to 1 week to process. Once a published course section is cancelled it will still 
appear in Workday but will be hidden and will have the course cancellation tag attached. 

More information about how to cancel a course section can be found in the Workday Student Course 
Scheduling Canvas Course. 

 

Troubleshooting 
What if you can’t get TT to open?  
If the Enterprise Timetabler (TT) icon on the taskbar is at the bottom of the screen, but it won’t it open, 
please try the following: 

 

1. Hover over the TT icon on the taskbar at the bottom of the screen until a grey box appears 
above the icon. 

2. Right click on the grey TT box and select Maximize. 
 

What if your instructor is not showing in TT? 
If an instructor is not showing up in TT, they may not have an active appointment in Workday, as the 
instructor eligibility syncs from Workday. If the instructor has an active teaching appointment, T-Reps 
will need to ensure that the Designate Instructor Eligibility Task has been completed in Workday. To 
find instructions for this step, please refer to the Teaching Assignment Module of the Workday Student 
Course Scheduling Canvas Course. If the instructor does not have an active teaching appointment in 
Workday follow up with your respective HR department.  It may be necessary to add an instructor to a 
course close to the start of an Academic Period based on their date of their Academic Appointment. 

 
Why doesn’t a room appear when I click the ‘Search’ button even though I know it’s available? 
Please review and consider these possibilities: 

• The planned size in the Activity Editor may exceed the seat capacity of the requested room.  
• Your term dates and/or start and end time may be incorrect. 
• The room may be booked on one of your scheduled days.  
• Have you checked the room availability on the Scientia Online Timetable? Make sure you are 

checking the corresponding academic year, as each year will have new link.  
• The room requirements selected do not match the room requirements in the room 
• The room may not be included in the selected zone. You will have to remove the zone 

requirement (e.g. Z: ENGL) for the room to appear. 
 

What if the course is not appearing in Workday? 
Please review and ensure all of the below are completed: 

• Did you writeback your changes?  
• Has it been more than 30 minutes? Activity transfer from Timetabler to Workday can take 15-

30 minutes for most updates. Some complex updates with JTA’s may take longer.  
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• Did you alter the section ID? Section IDs should be three characters and cannot be changed 
after the original section ID has been written back to the system. If you have modified the 
section ID after it was saved, please contact Scheduling Services. 

• Has the course recently had a curriculum change? You can view the version history in Workday 
on the course definition. 

• Does the course section activity type match one of the Required Instructional Formats? 
• Is the course scheduled and tagged as Arranged? 
• When the update does not appear the following morning, please submit a Course Scheduling 

Request Form for assistance. 
 

Exporting Activity Lists and Timetables from Enterprise Timetabler 
How to export a list of activities 
You can use this list to confirm your scheduled/arranged sections. 

1. Go to the Activity Filter window in the Views section of Timetabler.  
2. Click on the Categories tab, select the Departments that you would like to export and 

click Apply Filter.  
3. Ensure that you have added all the required columns including the Tag Names column 

so that you can distinguish arranged sections.  
a. Review the Column Views & Filtering section for help with adding columns. 

4. Click File > Export > Activities to export an .xls file.  

 

mailto:schedulingservices@students.ubc.ca
https://ubc.service-now.com/selfservice?id=sc_cat_item_v2&sys_id=322a97611b4a3450b8c7ff3ecc4bcb59
https://ubc.service-now.com/selfservice?id=sc_cat_item_v2&sys_id=322a97611b4a3450b8c7ff3ecc4bcb59


Scientia Course Scheduling User Guide 
Scheduling Services 

schedulingservices@students.ubc.ca  
 

Last Updated: May 5, 2025  23 
 

  

How to print a timetable 
A timetable of activities can be exported from Scientia through Enterprise Timetabler (TT). 
 
Once you have a list of activities you want to see in a timetable layout: 

1. Go to File > Print > Current Timetable 
2. Once Current Timetable is selected, a new window will open with a timetable 
3. Print file. 

 

 

Conclusion 
The UBC Vancouver course scheduling process relies on the integral support of Timetabling 
Representatives (T-Reps) for each cycle. Communication and collaboration between the Scheduling 
Team and academic units helps ensure we are able to provide a viable course schedule to the UBC 
Vancouver community. Thank you for your time and effort in using a number of systems, as well as, 
following timelines and business processes.  
 
While this User Guide focuses on Scientia, step-by-step guides and information about new processes 
and terminology for Workday, can be found in the Workday Student Course Scheduling Training. This 
includes how to complete the course section definition details to prepare courses for registration. 
Additional resources can be found on the Scheduling Services Website. 
 
If you have feedback or suggestions on how to improve the information presented here, please contact 
schedulingservices@students.ubc.ca.  
 

Thank you also for taking the time to review this guide! 
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